
 

 



EKSPRESIVNOST CRNO-BIJELE FOTOGRAFIJE 

 

 

Da li ste se ikada zapitali zašto još uvijek postoji crno-bijela fotografija?                           
Od pronalaska kolor fotografije, koju su, usput budi rečeno, civilizaciji podarila 
braća Limijer i davne 1907. godine omogućili njeno komercijalno korištenje , ljudi 
su bili fascinirani ovim tehnološkim napretkom i željeli su da predstave svijet na 
fotografiji onako kao što ga vidimo u stvarnosti što je naravno uključivalo i boju .                       
Zašto onda i danas fotografi svoje slike prikazuju u crno-bijeloj tehnici, kada je 
fotografija u boji toliko dostupna?                                                                                              
Ako na vašoj internet tražilici ukucate "Fine art photography" vidjećete da je više 
od 50% prikazanih slika monohromno.                                                                                             
Pa, postoje dobri razlozi za ovo. Evo nekoliko  argumenta :                                                             
Počeću sa citatom Teda Granta, kanadskog fotoreportera:  "Kad fotografišete ljude 
u boji, fotografišete njihovu  odjeću. Ali kad ih fotografišete u crno-bijeloj tehnici, 
fotografišete njihove duše. "                                                                                                    
Uklanjanje boje sa portreta, omogućava gledaocu da se koncentriše na osobine 
lica i dekodira emocije osobe. Gledajući na osobi lice, a posebno oči, bez ometanja 
boje, gledalac se može lakše povezati sa emocionalnim statusom te osobe.  

         

Sljedeći argument u korist crno-bijele fotografije je u vezi citata kojeg je dao  
Alberto Giacometti. (Alberto Đakometi) švicarski nadrealni kipar :                                                       
"Cilj umetnosti nije da reprodukuje stvarnost, već da stvori realnost istog 
intenziteta".                                                                                                                                            
Mi vidimo svijet u boji i stoga je realnost povezana sa prisustvom boje. Shodno 
tome, crno-bijela slika teži da nas udaljava od preciznog prikaza stvarnosti i 
prenese gledaoca u kraljevstvo apstrakcije, reducirajući  sliku na čiste tonove, 
linije i oblike.                                                                                                                    
CB fotografija, da bi bila uspešna, mora reducirati scenu na svoje osnovne 
elemente, odbacujući dio informacija. Ovo se može uraditi  dobro osmišljenom  
kompozicijom, ali  u značajnoj mjeri i putem uklanjanja informacija o boji. 
Navedeno može dobro da  ilustruje sljedeća fotografija: 



Svjedočimo efekatu jedinstva nekoliko likovnih 
faktora kao što su perspektiva, pravilna tonska zastupljenost, ponavljajući 
elementi (repeticija), pravilo trećina i smještaj glavnog subjekta. Eventualno 
prisustvo boje samo bi nas dekoncentrisalo u  težnji za potpunim doživljajem 
ovako skladnog spoja svih drugih likovnih elemenata.  Da bi dobio 
visokokvalitetne crno-bijele fotografije, fotograf mora ovladati  nekim bitnim 
tehničkim i estetskim pretpostavkama iz ove oblasti. 

 Raspon tonova                                                                                                                     
Širok raspon tonova poželjan je za uspješnu fotografiju, a crno -bijela fotografija 
omogućava tonalitet koji se kreće od apsolutne crne do čiste bijele boje. Za lakše 
razumijevanje tonskih ili valerskih vrijednosti koriste se valerske skale tonova. 
Najpogodnija je skala od 9 tonova, sa postupnom gradacijom od bijelog 
označenog brojem 1 do crnog označenog brojem 9.   

    

 Isto se ne može postići fotografijom u boji, zbog  prekomjernog zasićenja i 
paljenja boja. Oku prija pogled na crno-bijelu fotografiju koja sadrži punu valersku 
skalu. Ovu tvrdnju ilustrujem fotografijama prirode iz Yosemite National Park ,  
fotografskog genijalca Ansela Adamsa. 

 

https://en.wikipedia.org/wiki/Yosemite_National_Park


   

 

          

      

   



High key                                                                                                            
Uspješne crno-bijele slike ne moraju uvijek sadržavati ravnomjernu kombinaciju 
tonova.  Govoreći o tonovima  u monohromnoj fotografiji neizbježna je priča o 
„high key“ tehnici. 

    

 

Ova tehnika  najbolje funkcionira kada imate svijetlu pozadinu s kojom želite raditi 
u mekom, raspršenom , difuznom osvjetljenju kako biste spriječili da previše 
tamnih sjena uništava high key efekt.    Najpodesniji motivi za primjenu ove 
tehnike su mrtva priroda i portreti  gdje često imate kontrolu nad osvjetljenjem.                                   
Ali nemojte smetnuti sa uma mogućnost snimanja vrhunskih pejzaža. Snijeg ili 
magla apriori u velikoj mjeri garantiju dobar rezultat jer na  takvim motivima  
prirodno dominiraju svijetli tonovi. 



 Low key                                                                                                                       
Suprotno od gore navedene tehnike, pokušajte snimati prizore sastavljene 
uglavnom od srednje sivih do tamnih tonova. Tamni tonovi daju osjećaj misterije, 
što ga čini učinkovitom tehnikom za ekspresivne  dramatične portrete i isticanje 
ljepote ljudskog tijela.  

           

      

         

   



  Za uspješne low key fotografije morate osigurati da malo ili nimalo svjetla ne 
padne na pozadinu, tako da samo glavni predmet osvijetli bočnim ili visokim 
pozadinskim svjetlom. To se obično postiže kontroliranjem osvjetljenja upotrebom 
bljeskalice ili kontinuirane osvjetljenosti. Ponekad može pomoći čak i svjetiljka za 
čitanje 

Naglašavanje svjetla                                                                                        
Svjetlost i sjene kompenziraju  nedostatak boje. Razmislite o snažnom dojmu 
dugih intenzivnih sjena ili snažne siluete predmeta s pozadinskim osvjetljenjem, 
uveliko istaknutima u crno-bijelim slikama. Na crno-bijeloj slici možda ćemo 
propustiti informacije o boji lijepog zalaska sunca, ali s druge strane možemo 
uživati u svjetlu. 

        

    



Svjetlost je suština fotografije, stoga svaki alat koji ga naglašava ali i njegovu 
suprotnost- sjene,  pomaže da se stvori bolja slika. 

Grafika u cb kompoziciji                                                                                                                                                                                                                                                                                                                       
Jednostavni oblici i linije i snažna kontrastna kompozicija  praktično garantuju 
upečatljive crno--bijele slike.                                                                                                                                                    
Da biste maksimalno iskoristili grafičke oblike, pokušajte učiniti  kompoziciju što 
jednostavnijom. Ljudske tvorevine kao što je arhitektura ili  stepenište  sa svojim 
pravim i zakrivljenim linijama i dramatičnim uglovima  su poželjni kao motiv . 

     

         

                                                                 

 



Likovi ljudi u relaciji sa pozadinskim linijama mogu rezultirati efektnim grafičkim 
rješenjem. 

       

       

         

Konceptualni fotografski izraz nalazi najjajče uporište u ovako snažnim crno-
bijelim grafikama. 

           

 



Koristite polarizacioni filter  

    

       Tradicionalni filteri u boji koji se koriste za crno-bijeli film nisu pogodni za 
digitalne kamere, ali još uvijek možete povećati kontrast u grafičkim crno-bijelim 
snimcima koristeći polarizator. Rotiranjem filtera moći ćete zatamniti plavo nebo, 
čineći prisutne objekte kao što su zgrade ili oblaci jasnijim.                              
Polarizator će takođe ukloniti refleksije od nemetalnih objekata kao što su staklo ili 
voda, što doprinosi kvalitetu više crno-bijele slike 

   Koristite ND filter                                                                                                      
Jedan od najpopularnijih načina za dobijanje jednostavnih grafičkih slika je 
korišćenje dugih ekspozicija. Ova tehnika, koja se koristi ili pod oskudnim 
svjetlosnim uslovima, ili sa snažnim ND filterom, učiniće vodu i oblake glatkim, u 
mekanom zamućenju, fokusirajući svu pažnju na fiksne objekte u kadru. Kako ćete 
se baviti nekim prilično dugim ekspozicijama (u nekim slučajevima 30 sekundi ili 
duže), stativ je neophodan komad kompleta. 

     

   



       

      

 

Minimalizam  

Minimalizam kao fotografski izraz često odbacuje boju. Nema sumnje da odsutnost 
boja doprinosi,  između ostalog, ostvarenju minimalističkog efekta u fotografiji. Ali 
postoji još jedna značajka koja doprinosi uspješnom dobijanju minimalističkog 
rezultata  a to je negativni prostor.  Pod  pojmom negativni prostor misli se na 
područje u kompoziciji  koje nema prepoznatljive objekte koji bi mogli da skrenu 
pažnju s glavnog objekta. Crno i bijelo naglašava ova područja, što može biti još 
više istaknuto upotrebom jakog kontrasta. 

         



Tekstura i detalji 

Jasni detalji ili jake teksture poput kože pojedinih životinja, ljudske kože, drveta, 
kamena, popucanih premaza farbe na starom metalu i slično,  mogu biti pogodni 
motivi za  crno-bijele fotografije. Jako bočno osvjetljenje, bilo prirodno ili 
vještačko  je savršeno za isticanje teksture na  bilo kojem  predmetu jer naglašava 
detalje.  

    

      

     

 

Čak i hromatski šum, kojeg, usput budi rečeno ubrajamo u jedan od 
kompozicionih faktora,  u crno-bijeloj verziji  doprinosi  stvaranju određene 
atmosfere. Unošenjem zrnatosti u sliku promijeniće se njezina atmosfera.  Najbolje 
za tretman zrnatošću su kontrastne slike, dokumentarne snimke, oblačni i 
magloviti pejzaži i gradski prizori. Ne dolazite u iskušenje da povećate ISO 
postavke  na aparar. Puno je bolje zrnatost dodavati tokom postupka obrade 
snimka. 



      

Motivi koji nisu poželjni za crno-bijelu fotografiju 

Nema apsolutnog pravog ili pogrešnog pravila kada se radi o izboru motiva za 
crno-bijelo fotografisanje. I sam sam protivnik isključivosti kad je u pitanju 
fotografija. To se kosi sa stavom  fotografskih krativaca kojima je umjetnost 
bezgranično polje izražavanja. Ali jednostavno ćete nekad doći do scene u kojoj se 
dodiruju  boje koji ne funkcionišu dobro u monohromu.                                                   
Evo nekoliko primjera šta bi trebalo izbjeći prilikom traženja odgovarajućih motiva 
za crno-bijelu fotografiju. 

Zaštita atmosfere u motivu                                                                                               
Ako se scena koju snimate oslanja na boju koja je bitna za atmosferu,  bolje da 
zadržite sliku u boji, kao u našoj sceni snimljenoj u malom dućanu.                                
Još jedan dobar primer je izlazak ili zalazak sunca. Uvijek se pitajte šta slika gubi 
bez suptilnih koloritnih nijansi. 

      

 

Komplementarne boje nije poželjno konvertovati u CB 

Da se podsjetimo, komplementarne boje su one koje se nalaze na suprotnim 
stranama hromatskog kruga.  Njihovo uparivanje u kolor fotografiji je itekako 
poželjno, ali ne i u monohromnoj. 



 Subjekti koji se oslanjaju na komplementarne boje,  poput 
ljubičastog kaćuna na zelenom travnjaku, obično ne funkcionišu dobro u crno-
bijeloj tehnici. To je zato što će te dvije boje izgledati bezizražajno jer  imaju sličan 
ton kada se konvertuju u greyscale  mod. 

      

Evo  i drugog primjera para komplementarnih boja koje se ne podnose u 
monohromnoj verziji iako se dobro druže u koloritnoj. To su žuta i plava: 

     

 

 Cvijeće i folklorni motivi  

Motivi kod kojih je po prirodi stvari boja neizostavna komponenta postojanja i 
najprivlačniji razlog za fotografisanje nisu preporučljivi za snimanje u 
monohromnoj tehnici. Mislim na cvijeće koje je priroda obdarila njegovim  najjačim 
atributom,  bojom.                                                                                                                                  
Tu svakako ubrajam i folk scene sa svim svojim koloritnim sadržajima  koje je 
narodna tradicija vijekovima pohranjivala i ostavljala svjedočenje o svom 
postojanju. Mislim da u tom slučaju fotograf nema ni moralno pravo da svojim 



monohromatskim pristupom  eliminiše boju iz takvog motiva. Zamislite kako bi 
izgledale fotografije praznika Holi u Indiji, praznika boje, a bez boja na vašoj slici. 

    

 

Međutim, kao i u svemu, izuzetak potvrđuje pravilo. Prikazati cvijeće i biljke u 
monohromnoj verziji je opravdano kada kadriranjem odaberemo odnos oblika, 
linija i tonova tako da prvobitni motiv dovedemo gotovo do neprepoznatljivosti 
idući gotovo ka apstrakciji. Mora se priznati da ovakav pristup rezultira oku mio i 
dekorativan rezultat sa skladnim odnosom grafičkih elemenata. 

     

    



Tehnike konverzije kolor fotografije u monohromnu 
Postoji  mnogo načina pretvorbe  kolor slike u monohrom.  Ovdje ćemo pomenuti 
samo nekoliko njih jer za ovako široku materiju bi trebalo posebno tematsko 
predavanje.                                                                                                                                      
 
Snimanje u „Black and White Preview Mode“                                                            
Jedan od dobrih načina snimanja crno-bijele fotografije jeste da odmah pri 
snimanju vidite snimak sa crno-bijelim pregledom visokog kontrasta čiji nivo 
možete podesiti u odgovarajućem modu. Evo primjera fotografija koje sam  snimio 
upravo na taj način, direktnim podešavanjem CB kontrasta u mom fotoaparatu:   

        

Većina današnjih DSLR-a će vam omogućiti snimanje u RAW plus JPEG. Tako 
možete podesiti JPEG u monohromatski (crno-bijeli mod) koji će vam odmah 
omogućiti gledanje finalne scene u monohromu. Kada fotografišete na taj način, 
vidjećete da možete imati potpunu kontrolu nad uređivanjem RAW slike kasnije u 
Photoshop-u ili nekom drugom programu za obradu fotografija.  Vaš Raw file je 
sačuvao sve kolor informacije za slučaj da se ipak opredijelite za obojenu verziju. 

 

Postprodukcija  u grafičkim programima                                                     
„Grayscale mode“  konverzija                                                                                  
U  Photoshopu je potrebno samo nekoliko poteza mišem za dobivanje crno bijele 
iz kolor fotografije. Većina vjerojatno misli da je o takvim temama nepotrebno 
pisati jer svi znaju da je cijeli proces vrlo jednostavan. Treba samo proći kroz 3 
izbornika "Image > Mode > Grayscale" i problem je riješen. Za neke možda i jeste. 
Rezultat će na žalost biti osrednje kvalitete  sa slabijim kontrastom te ne bih 
preporučio ovaj postupak. 

"Channel Mixer" konverzija                                                                                        

Za one koji žele bolji rezultat rješenje je u izborniku "Image" -> "Adjustments" -> 

"Channel Mixer" odnosno još je bolja varijanta otići na: "Layer -> New Adjustment 

Layer -> Channel Mixer". Tamo se nalazi vrlo moćan alat koji će na kvalitetan način 

napraviti pretvorbu iz kolora u crno-bijelo i omogućiti dodatne opcije podešavanja 



koje ponekad ispadaju ekvivalentno korištenju filtera prilikom snimanja crno-bijele 

fotografije.  Označimo opciju "Monochrome" i dobili smo mnogo kvalitetniju crno 

bijelu sliku negu u prethodnoj greyscale pretvorbi.  Uz ovu jednostavnu opciju 

Channel Mixer nam nudi cijeli niz dodatnih podešavanja, s kojima se možemo 

poigrati na razne načine.  Svaku  boju u tri osnovna kanala boja je moguće 

podešavati po vašem ukusu i u praktično neograničenom broju kombinacija. 

Sljedeća preporuka je „Gradient Map“ konverzija  koja daje kontrastan i brz 

rezultat  u neku od monohromnih nijansi u samo nekoliko koraka: U izborniku (iliti 

paleti) Layer  kliknite na dnu izbornika na simbol ispod kojeg se krije podalatka 

"Create new fill or adjustments layer". U prozoru koji će vam se otvoriti pronđite 

pri dnu Gradient Map. Samim tim potezom dobijate „po difoltu“ dobro podešene 

CB tonove.  Ako želite više, eksperimentišite sa ostalim, vrlo inventivnim 

podalatkama dok ne dobijete željeni monohromni rezultat.                                                  

Za poređenje,  evo rezultata u nekoliko navedenih  pretvorbi :                                                           

                                           
Originalan kolor fotografija                               Greyscale konverzija 

                                               
Channel Mixer konverzija                              Gradient Map konverzija                                                                        



Obradi fotografiju u Photoshopu nisu svi toliko verzirani da bi za kratko vrijeme 

postigli zadovoljavajući rezultat, pa se i u ovom slučaju pronašlo rješenje u vidu 

dopunskih aplikacija (plug-inova). Njih ima pregršt, ali se kao i uvijek neki izdvoje 

kao najbolji poput Google Nik Software Silver Efex Pro koji može raditi samostalno 

(standalone) ili kao dodatak  kroz Photoshop ili Lightroom                                                                                                                                  

Za korisnike Winows operativnog sistema evo direktnog linka preko kojeg možete 

besplatno  preuzeti  i instalirati cijeli paket „Google Nik Sofware“ u čijem sastavu 

se nalazi i Silver Efex Pro :                             

https://rebrand.ly/nikcollection_windows          

                                        Za kraj bih  mogao zaključiti  da su kolor fotografija i 

crno-bijela fotografija  dva različita jezika i treba znati govoriti oba. To 

praktično znači da se fotograf mora, kad se nađe pred objektom svoga 

snimanja,  pravovremeno opredijeliti kojim od ova dva jezika progovorit. 

Kolor ima svoju snagu, ima dimenziju više, što rad u neku ruku čini 

lakšim. Crno-bijela opcija je na neki način čišća,ali  treba više paziti na 

kompoziciju. Dobra fotografija je dobra fotografija, a je li u boji ili crno-

bijela, to je sasvim sporedno. Ili je dobra ili nije.  

 

 

https://www.youtube.com/redirect?event=video_description&v=UMyQMkIkx0k&redir_token=ac9pKS74C54jApVJbCN3kl1ud258MTU0MTQ0NTU0OEAxNTQxMzU5MTQ4&q=https%3A%2F%2Frebrand.ly%2Fnikcollection_windows

